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Μηχάνημα Χάραξης Λέιζερ 10W με Κυλινδρικό Ρόλερ 
 
 



Μέρος 1: Δήλωση Ασφαλείας Πριν την Εγκατάσταση 
Πριν χρησιμοποιήσετε το μηχάνημα χάραξης με λέιζερ, παρακαλείστε να 
διαβάσετε προσεκτικά αυτόν τον οδηγό ασφαλείας. Περιέχει πληροφορίες για 
καταστάσεις που απαιτούν ιδιαίτερη προσοχή, καθώς και προειδοποιήσεις για 
επικίνδυνες πρακτικές που ενδέχεται να προκαλέσουν ζημιές στην περιουσία 
σας ή ακόμη και να απειλήσουν την προσωπική σας ασφάλεια. 

 
1. Το προϊόν ανήκει στην Κατηγορία 4 λέιζερ (Class 4). Το ίδιο το σύστημα 

λέιζερ πρέπει να πληροί τις απαιτήσεις του προτύπου IEC 60825-1 
(τελευταία έκδοση). 

o Σε διαφορετική περίπτωση, απαγορεύεται η χρήση του 
προϊόντος. 

2. Αν το προστατευτικό περίβλημα διαθέτει θυρίδα πρόσβασης τύπου 
"walk-in" (δηλαδή όπου μπορεί να εισέλθει άνθρωπος), τότε: 

α) Πρέπει να υπάρχουν μηχανισμοί ασφαλείας ώστε οποιοδήποτε άτομο στο 
εσωτερικό του περιβλήματος να μπορεί να αποτρέψει την ενεργοποίηση λέιζερ 
ισχύος Κατηγορίας 3Β ή 4. 
β) Πρέπει να υπάρχει μηχανισμός ειδοποίησης (π.χ. ηχητικό ή οπτικό σήμα) 
ώστε να ενημερώνονται άτομα για την εκπομπή ακτινοβολίας λέιζερ: 

o Κατηγορίας 3R (για μήκη κύματος <400 nm ή >700 nm) 
o ή Κατηγορίας 3Β / 4, για άτομα που μπορεί να βρίσκονται μέσα στο 

περίβλημα. 
γ) Όταν προβλέπεται ή είναι εύλογα πιθανή η παρουσία ατόμου στο εσωτερικό 
του περιβλήματος κατά τη λειτουργία, πρέπει να αποτρέπεται η εκπομπή 
λέιζερ Κατηγορίας 3Β ή 4 μέσω μηχανικών/τεχνικών μέσων προστασίας. 

 
       Σημείωση: Μέθοδοι αποτροπής έκθεσης κατά την παρουσία ανθρώπων στο 
εσωτερικό του περιβλήματος μπορεί να περιλαμβάνουν: 

• Χαλάκια πίεσης (pressure-sensitive mats) 
• Ανιχνευτές υπερύθρων (infrared detectors) 
• Ή άλλα συστήματα ασφάλειας που διακόπτουν αυτόματα τη λειτουργία 

του λέιζερ. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Μέρος 1 (συνέχεια): Δήλωση Ασφαλείας Πριν την Εγκατάσταση 
3. Το ίδιο το λέιζερ διαθέτει προστατευτικό κάλυμμα, το οποίο είναι 

στερεωμένο με βίδες ή μαγνήτες. 
o Όταν το λέιζερ είναι εγκατεστημένο στο μηχάνημα χάραξης, το 

κάλυμμα πρέπει να ελέγχεται ώστε να είναι αξιόπιστα 
ασφαλισμένο και να μην αφαιρείται όσο η συσκευή είναι 
ενεργοποιημένη. 

4. Το μηχάνημα χάραξης λέιζερ διαθέτει κουμπί έκτακτης ανάγκης 
(emergency stop), το οποίο μπορεί να διακόψει άμεσα την έξοδο του 
λέιζερ σε περίπτωση απρόβλεπτης κατάστασης. 

5. Διαθέτει επίσης κουμπί επαναφοράς (reset), το οποίο επιτρέπει την 
επανεκκίνηση της λειτουργίας μόνο μετά την επιβεβαίωση ασφαλούς 
κατάστασης, δηλαδή αφού αρθεί το interlock ή η διακοπή έκτακτης 
ανάγκης. 

6. Τοποθετήστε σήμανση προειδοποίησης σε οποιοδήποτε παράθυρο ή 
άνοιγμα μπορεί να: 

o παρατηρεί άμεσα την εκπομπή λέιζερ, ή 
o δέχεται έμμεσα ακτινοβολία από το λέιζερ. 

7. Αν προκληθεί κάψιμο σε δέρμα ή μάτια από το λέιζερ, παρακαλείστε να 
μεταβείτε άμεσα σε πλησιέστερο νοσοκομείο για εξέταση και 
θεραπεία. 

 
Το φως του λέιζερ μπορεί να προκαλέσει σοβαρές βλάβες στα μάτια και το 
δέρμα. Μην εκθέτετε απευθείας τα μάτια ή το δέρμα σας στο φως του λέιζερ. 
Αυτό το προϊόν εκπέμπει συγκεντρωμένη δέσμη λέιζερ μέσω οπτικού φακού. 
Το φως που εκπέμπεται, είτε άμεσο είτε ανακλώμενο, είναι εξαιρετικά 
επικίνδυνο, καθώς μπορεί να διανύσει μεγάλες αποστάσεις διατηρώντας υψηλή 
οπτική πυκνότητα. 
Κατά το χειρισμό του προϊόντος: 

• Φορέστε κατάλληλα γυαλιά προστασίας λέιζερ (OD5+) για την 
προστασία των ματιών σας από όλους τους τύπους ακτινοβολίας λέιζερ 
– ακόμα και από έμμεσο ή διαχεόμενο φως. 

• Η ανακλώμενη ή διαρρέουσα ακτινοβολία που φτάνει σε ανεπιθύμητες 
περιοχές πρέπει να απορροφάται ή να μειώνεται (attenuation). 

 
2.1 Ασφάλεια από Λέιζερ 

• Έχουμε τοποθετήσει ασπίδα λέιζερ η οποία φιλτράρει μεγάλο μέρος της 
διαχεόμενης αντανάκλασης του σημείου λέιζερ. 

• Ωστόσο, συνιστάται πάντα η χρήση γυαλιών προστασίας λέιζερ κατά τη 
χρήση του μηχανήματος, ώστε να αποφεύγονται βλάβες στα μάτια. 

• Αποφύγετε την έκθεση του δέρματος σε δέσμες λέιζερ Κατηγορίας 4, 
ειδικά σε κοντινές αποστάσεις. 

• Οι έφηβοι πρέπει να χρησιμοποιούν τη συσκευή μόνο με επίβλεψη 
γονέα. 

• Μην αγγίζετε τη μονάδα χάραξης λέιζερ όσο το μηχάνημα είναι 
ενεργό. 

 



2.2 Πυρασφάλεια 
• Κατά την κοπή, η έντονη δέσμη λέιζερ προκαλεί πολύ υψηλές 

θερμοκρασίες και εκλύει θερμότητα, καίγοντας την επιφάνεια του 
υλικού. 

• Ορισμένα υλικά μπορούν να αναφλεγούν, παράγοντας καπνούς, αέρια 
και αναθυμιάσεις στο εσωτερικό του εξοπλισμού. 

• Συνήθως σχηματίζεται μικρή φλόγα όταν η δέσμη χτυπάει το υλικό. Αυτή 
κινείται με τη δέσμη και σβήνει αμέσως μετά. 

    Μην αφήνετε ποτέ το μηχάνημα χωρίς επίβλεψη κατά τη διάρκεια της 
χάραξης. 
Μετά τη χρήση: 

• Καθαρίστε προσεκτικά τυχόν υπολείμματα, σκόνη και εύφλεκτα υλικά 
από τη συσκευή. 

• Έχετε πάντα έναν πυροσβεστήρα σε κοντινή απόσταση για ασφάλεια. 
Κατά τη λειτουργία της μηχανής, παράγονται καπνοί, σωματίδια και 
ενδεχομένως τοξικά αέρια από το υλικό (ιδίως όταν πρόκειται για πλαστικά ή 
άλλα εύφλεκτα υλικά). 
Αυτά τα υποπροϊόντα μπορεί να είναι επικίνδυνα για την υγεία. Βεβαιωθείτε ότι 
ο χώρος είναι επαρκώς αεριζόμενος ή χρησιμοποιήστε σύστημα 
απορρόφησης καπνού. 
 
 
2.3 Ασφάλεια Υλικών 

• Μην χαράσσετε υλικά αγνώστου σύστασης ή προέλευσης. 
• Συνιστώμενα υλικά: Ξύλο, μπαμπού, δέρμα, πλαστικό, ύφασμα, χαρτί, 

αδιαφανές ακρυλικό, γυαλί. 
• Μη συνιστώμενα υλικά: Μέταλλα, πολύτιμοι λίθοι, διαφανή ή 

ανακλαστικά υλικά κ.λπ. 
 

2.4 Ασφάλεια Χρήσης 
• Χρησιμοποιείτε το μηχάνημα μόνο σε οριζόντια θέση και βεβαιωθείτε ότι 

είναι σταθερά στερεωμένο για να αποφύγετε μετατοπίσεις ή πτώσεις 
που μπορεί να προκαλέσουν πυρκαγιά. 

• Απαγορεύεται να στρέφετε τη δέσμη λέιζερ προς: 
o ανθρώπους, 
o ζώα ή 
o εύφλεκτα αντικείμενα, 

είτε το μηχάνημα λειτουργεί είτε όχι. 
 

2.5 Ασφάλεια Ρεύματος 
• Για την αποτροπή ατυχημάτων όπως πυρκαγιά ή ηλεκτροπληξία, το 

μηχάνημα διαθέτει τροφοδοτικό με γείωση. 
• Πάντοτε να συνδέετε το φις του μηχανήματος σε πρίζα με γείωση, για 

την ασφαλή λειτουργία του λέιζερ. 
 
 

 



2.6 Ασφάλεια Περιβάλλοντος 
• Κατά την εγκατάσταση εξοπλισμού χάραξης/κοπής, βεβαιωθείτε ότι ο 

χώρος εργασίας είναι καθαρός. 
• Μην υπάρχουν εύφλεκτα ή εκρηκτικά υλικά γύρω από το μηχάνημα. 
• Πρέπει να τοποθετείται μεταλλική πλάκα στο κάτω μέρος του 

μηχανήματος κατά τη διάρκεια χάραξης ή κοπής, για να αποτρέπεται η 
μετάδοση θερμότητας ή φωτιάς στην επιφάνεια εργασίας. 

 
 
Μέρος 3: Αποποίηση Ευθύνης & Προειδοποίηση 

• Το προϊόν δεν είναι παιχνίδι και δεν είναι κατάλληλο για άτομα κάτω 
των 15 ετών. 

• Μην επιτρέπετε σε παιδιά να αγγίζουν τη μονάδα λέιζερ. 
• Ιδιαίτερη προσοχή απαιτείται όταν λειτουργείτε τη συσκευή σε 

χώρους με παιδιά. 
 

Αυτό το προϊόν είναι μονάδα λέιζερ. Παρακαλούμε διαβάστε προσεκτικά το 
εγχειρίδιο οδηγιών λειτουργίας. 

 
      Νομική Επισήμανση – VEVOR 

• Η VEVOR διατηρεί το δικαίωμα να ενημερώσει αυτήν την αποποίηση 
ευθύνης και τον οδηγό ασφαλούς χρήσης. 

• Παρακαλούμε να διαβάσετε αυτό το έγγραφο προσεκτικά πριν από τη 
χρήση του προϊόντος ώστε να κατανοήσετε τα νόμιμα δικαιώματά σας, 
τις ευθύνες σας και τις οδηγίες ασφαλείας. 

• Σε διαφορετική περίπτωση, ενδέχεται να προκύψουν ζημιές σε 
περιουσία, ατυχήματα ή κινδύνους για την προσωπική σας ασφάλεια. 

 
Μόλις ξεκινήσετε να χρησιμοποιείτε το προϊόν: 

• Θεωρείται ότι έχετε κατανοήσει και αποδεχτεί όλους τους όρους και το 
περιεχόμενο του παρόντος εγγράφου. 

• Ο χρήστης φέρει πλήρη ευθύνη για τις ενέργειές του και οποιεσδήποτε 
συνέπειες προκύψουν από αυτές. 

• Ο χρήστης συμφωνεί να χρησιμοποιεί το προϊόν μόνο για νόμιμους 
σκοπούς και αποδέχεται πλήρως τους όρους του παρόντος καθώς και 
οποιεσδήποτε σχετικές πολιτικές ή οδηγίες της VEVOR. 

 
 
 
 
 
 
 
 
 
 



Για να μπορεί η VEVOR να προσφέρει τεχνική υποστήριξη ή υπηρεσίες μετά 
την πώληση, ο χρήστης οφείλει να παρέχει: 

• Τα αρχικά αρχεία χάραξης ή κοπής, 
• Τις παραμέτρους ρυθμίσεων του λογισμικού, 
• Πληροφορίες για το λειτουργικό σύστημα, 
• Βίντεο της διαδικασίας χάραξης ή κοπής, 
• Τα βήματα λειτουργίας πριν την εμφάνιση του προβλήματος ή της 

βλάβης. 
Αν δεν προσκομιστούν τα παραπάνω, η VEVOR δεν φέρει ευθύνη για ζημιές ή 
αδυναμία παροχής εξυπηρέτησης. 

 
     ΠΡΟΕΙΔΟΠΟΙΗΣΗ: 
Ο χρήστης απαγορεύεται να αποσυναρμολογεί τη συσκευή χωρίς την 
καθοδήγηση τεχνικού προσωπικού της VEVOR. 
Σε περίπτωση παραβίασης, οποιαδήποτε απώλεια ή ζημιά βαρύνει 
αποκλειστικά τον χρήστη. 

 
Η VEVOR διατηρεί το αποκλειστικό δικαίωμα ερμηνείας του παρόντος 
εγγράφου, σύμφωνα με τη νομοθεσία. 
Διατηρεί επίσης το δικαίωμα να ενημερώνει, να τροποποιεί ή να καταργεί 
τους όρους χωρίς προειδοποίηση. 
 
 

 
 



 
 
 

 
 
 

 
 
 



 
 
 



 
 



 
 



 
 
 

 
 
 
 
 



Βασικές Λειτουργίες & Περιγραφή Εξαρτημάτων 
1. Διακόπτης Έκτακτης Ανάγκης (Emergency Stop Switch): 

Σε περίπτωση έκτακτης ανάγκης, πατώντας αυτό το κουμπί, η συσκευή 
σταματά αμέσως να λειτουργεί. 

o Για να το ξεκλειδώσετε, στρέψτε το κουμπί δεξιόστροφα ώστε να 
επανεκκινήσει το μηχάνημα. 

2. Υποδοχή Ρεύματος (Power Socket): 
o Τροφοδοσία DC 12V (μοντέλο A7) 
o Τροφοδοσία DC 24V (μοντέλο G3) 

3. Θύρα USB (USB Interface): 
Χρησιμοποιείται για σύνδεση με υπολογιστή μέσω καλωδίου USB και 
έλεγχο του μηχανήματος μέσω λογισμικού. 

4. Διακόπτης Λειτουργίας (Power Switch): 
Επιτρέπει τη χειροκίνητη ενεργοποίηση ή απενεργοποίηση του 
μηχανήματος. 

5. Υποδοχή TF Κάρτας (TF Card Slot): 
Εδώ εισάγετε κάρτα TF για λειτουργία χωρίς υπολογιστή. 
     Η κάρτα TF δεν περιλαμβάνεται – πρέπει να την προμηθευτείτε 
ξεχωριστά. 

6. Κουμπί Επαναφοράς (Reset Switch): 
Σε περίπτωση βλάβης ή όταν το μηχάνημα “κολλήσει”, πατήστε το 
κουμπί reset για να το επανεκκινήσετε. 

     Πριν τη χρήση, βεβαιωθείτε ότι ο διακόπτης έκτακτης ανάγκης βρίσκεται 
σε “ανυψωμένη θέση” (ξεκλείδωτος). 
 
 
Οδηγίες για Εξαγωγή Αρχείων σε Μορφή .nc και .gc 
1. Με το λογισμικό LaserGRBL 

1. Εισάγετε την εικόνα που θέλετε να χαράξετε ή να κόψετε στο 
LaserGRBL. 

2. Αφού ρυθμίσετε τις παραμέτρους χάραξης, όπως ταχύτητα και ισχύς 
λέιζερ, κάντε κλικ στο File (Αρχείο) και επιλέξτε Quick Save (Γρήγορη 
Αποθήκευση). 

3. Επιλέξτε ως διαδρομή αποθήκευσης την κάρτα TF και κάντε κλικ στο 
Save για να δημιουργηθεί το αρχείο σε μορφή .nc. 

 
2. Με το λογισμικό LightBurn 

1. Εισάγετε την εικόνα που θέλετε να χαράξετε ή να κόψετε στο LightBurn. 
2. Αφού ρυθμίσετε τις παραμέτρους χάραξης, όπως ταχύτητα και ισχύς, 

κάντε κλικ στο Save GCode (Αποθήκευση G-Code). 
3. Επιλέξτε την κάρτα TF ως διαδρομή αποθήκευσης και κάντε κλικ στο 

Save, ώστε να δημιουργηθεί το αρχείο σε μορφή .gc. 
 

       Σημείωση: Τα αρχεία .nc και .gc είναι κατάλληλα για χάραξη ή κοπή απευθείας 
από κάρτα TF, χωρίς τη χρήση υπολογιστή. 
 
Μέρος 6: Εγκατάσταση και Χρήση Λογισμικού 



1. Λήψη του Λογισμικού LaserGRBL 
• Επισκεφθείτε τον επίσημο ιστότοπο του LaserGRBL και κατεβάστε την 

τελευταία έκδοση του λογισμικού. 
2. Εγκατάσταση LaserGRBL 

• Εκτελέστε το αρχείο εγκατάστασης και ακολουθήστε τα βήματα για να 
ολοκληρώσετε την εγκατάσταση στον υπολογιστή σας (Windows). 

3. Προσθήκη Προσαρμοσμένων Κουμπιών (Custom Buttons) 
• Από το μενού "Custom Buttons", μπορείτε να δημιουργήσετε ή να 

προσθέσετε συντομεύσεις για κοινές εντολές (όπως ενεργοποίηση λέιζερ, 
επαναφορά, κ.λπ.). 

4. Σύνδεση του Μηχανήματος Χάραξης Λέιζερ 
• Συνδέστε τη συσκευή στον υπολογιστή μέσω USB καλωδίου. 
• Από το LaserGRBL, επιλέξτε σωστή θύρα COM και κάντε κλικ στο 

"Connect". 
5. Ρύθμιση Παραμέτρων Χάραξης 

• Ορίστε την ταχύτητα χάραξης, ισχύ λέιζερ, ανάλυση και άλλες 
παραμέτρους ανάλογα με το υλικό σας. 

6. Ρύθμιση Εστίασης Λέιζερ (Laser Focus) 
• Ρυθμίστε το ύψος του λέιζερ έως ότου το σημείο είναι όσο το δυνατόν 

πιο λεπτό και καθαρό πάνω στο υλικό. 
• Μπορεί να χρειαστεί να χαλαρώσετε/σφίξετε τις βίδες στήριξης του 

module. 
7. Τοποθέτηση/Ευθυγράμμιση (Positioning) 

• Χρησιμοποιήστε τη λειτουργία “Frame” για να δείτε την περιοχή χάραξης 
πριν ξεκινήσετε. 

• Τοποθετήστε το αντικείμενο στο σωστό σημείο βάσει του πλαισίου. 
8. Έναρξη, Τερματισμός Χάραξης ή Κοπής 

• Κάντε κλικ στο "Start" για να ξεκινήσει η χάραξη ή κοπή. 
• Μπορείτε να τερματίσετε ανά πάσα στιγμή με το κουμπί "Stop" ή κουμπί 

έκτακτης ανάγκης στη συσκευή. 
9. Οδηγός Εγκατάστασης LightBurn 

• Κατεβάστε το λογισμικό LightBurn και ακολουθήστε τις οδηγίες 
εγκατάστασης. 

• Δημιουργήστε νέο προφίλ για τη συσκευή σας, ρυθμίστε το πρωτόκολλο 
σύνδεσης (συνήθως GRBL), και προχωρήστε στη χάραξη. 

 
 
 
 
 
 
 
 
 
 
 
 

https://lasergrbl.com/
https://lightburnsoftware.com/


 
 
Μέρος 6: Εγκατάσταση και Χρήση Λογισμικού (αναλυτικά) 

 
1. Λήψη του LaserGRBL 
Το LaserGRBL είναι ένα από τα πιο δημοφιλή λογισμικά για DIY χάραξη με λέιζερ. 
     Ιστότοπος λήψης: http://lasergrbl.com/download/ 

 
2. Εγκατάσταση του LaserGRBL 

• Κάντε διπλό κλικ στο αρχείο εγκατάστασης για να ξεκινήσει η διαδικασία. 
• Πατήστε Next μέχρι να ολοκληρωθεί η εγκατάσταση. 
         (Εικόνα 1: Οθόνη εγκατάστασης του LaserGRBL) 

 
3. Προσθήκη Προσαρμοσμένων Κουμπιών (Custom Buttons) 

1. Το λογισμικό υποστηρίζει προσθήκη εξατομικευμένων κουμπιών. 
o Συνιστούμε τα επίσημα κουμπιά από το LaserGRBL. 
o      Κατεβάστε τα από: http://lasergrbl.com/usage/custom-

buttons/ 
         (Εικόνα 2: Πακέτο κουμπιών) 

2. Φόρτωση κουμπιών στο LaserGRBL: 
o Κάντε δεξί κλικ στον κενό χώρο δίπλα στα κάτω κουμπιά → Import 

Custom Button 
o Επιλέξτε το .zip αρχείο με τα κουμπιά και πατήστε "Yes" μέχρι να 

μην εμφανίζονται άλλα παράθυρα. 
         (Εικόνες 3, 4, 5: Διαδικασία εισαγωγής κουμπιών) 

 
4. Σύνδεση του Μηχανήματος Χάραξης 
Βήματα: 
A. Συνδέστε το μηχάνημα στον υπολογιστή μέσω USB. 
B. Συνδέστε την παροχή ρεύματος. 
C. Ανοίξτε το λογισμικό LaserGRBL. 
D. Επιλέξτε σωστή θύρα COM και ταχύτητα baud 115200. 

• Αν έχετε πολλαπλές συσκευές USB, εντοπίστε τη σωστή θύρα μέσω της 
Διαχείρισης Συσκευών (Device Manager) των Windows. 
E. Εγκαταστήστε τον CH340 driver: 

• Tools > Install CH340 Driver 
• Κάντε επανεκκίνηση του υπολογιστή. 

F. Πατήστε το εικονίδιο     (κεραυνός) στο LaserGRBL. Αν γίνει κόκκινο Χ, 
η σύνδεση είναι επιτυχής. 
G. Αν υπάρξει αποτυχία σύνδεσης, επαναλάβετε: 

• Tools > Install CH340 Driver 
• Επανεκκίνηση και νέα σύνδεση. 

 
5. Ρύθμιση Παραμέτρων Χάραξης 
Βήμα 1: Άνοιγμα αρχείου 

• File > Open File → επιλέξτε την εικόνα σας. 



• Υποστηριζόμενα αρχεία: .nc, .bmp, .jpg, .png, .dxf κ.ά. 
Βήμα 2: Παράμετροι εικόνας και λειτουργία χάραξης 
a. Ρυθμίσεις εικόνας: οξύτητα, φωτεινότητα, αντίθεση κ.λπ. 
b. Τρόπος χάραξης: 

• "Line to line tracking" 
• "1bit dithering" για ασπρόμαυρα ή γκρι. 
• Για κοπή: επιλέξτε vector ή centerline. 

c. Ποιότητα χάραξης: 
• Προτείνεται ρύθμιση "8" – εξαρτάται από την ισχύ του λέιζερ. 

d. Προεπισκόπηση: περιστροφή, καθρέπτης, περικοπή. 
e. Πατήστε Next για να περάσετε στις ρυθμίσεις ταχύτητας, ισχύος και 
διαστάσεων. 

Βήμα 3: Ρυθμίσεις ταχύτητας, ενέργειας και μεγέθους 
a. Προτεινόμενη ταχύτητα: 3000 mm/min (μπορεί να προσαρμοστεί ανάλογα 
με το υλικό). 
b. Εντολή λέιζερ: 

• M4 για 1bit dithering 
• M3 για άλλες λειτουργίες 
• Αν έχετε μόνο M3, βεβαιωθείτε ότι είναι ενεργοποιημένο στο GRBL. 

c. Ισχύς: εξαρτάται από το υλικό. 
d. Μέγεθος χάραξης: ορίστε τις επιθυμητές διαστάσεις και πατήστε 
Create. 

 
6. Ρύθμιση Εστίασης Λέιζερ 
Η εστίαση παίζει καθοριστικό ρόλο στην ποιότητα της χάραξης/κοπής. 

• Η συσκευή χρησιμοποιεί λέιζερ σταθερής εστίασης, όχι zoom. 
• Η εστίαση επιτυγχάνεται με τοποθέτηση του ειδικού φύλλου (fixed-

focus film) ανάμεσα στη δέσμη και το αντικείμενο. 
Βήματα: 
A. Μετακινήστε το λέιζερ πάνω από το αντικείμενο. 
B. Τοποθετήστε το φύλλο εστίασης επάνω στο αντικείμενο. 

• Για 5W: 2mm 
• Για 10W: 3mm 
• Για 20W: 4mm 

C. Χαμηλώστε ή σηκώστε το module ώστε η εστίαση να εφάπτεται στο 
φύλλο. 

 
 
 
 
 
 

 
 


